
T3ED Help Index

Since this is only a preview version of T3ED, some of the commands are not yet implemented, and others
have no available documentation yet. The following topics are available :

How To ...
What  ’  s new in this version ?  

           Downloading the latest version of T3ED
           NFS3 Tracks Overview
           Frequently asked questions

Commands
File menu
View menu
Edit-Modes menu
Edit-Tools menu
Help menu
Toolbar

NOTE : No detailed help is available for the commands in the Edit-Modes and Edit-Tools 
menus in this release.



What’s new in this version ?

This is Preview Version 0.02 of T3ED, released on January 11, 1999.
T3ED is Copyright (c) Denis Auroux, 1998-99    (e-mail : auroux@clipper.ens.fr).

Added since Version 0.01 :
- Smoothing properties dialog box for Block mode and Extended Point mode.
- Extra smoothing option for the Move XY and Move Z tools in Block mode : allows easy creating of ovals 
and high-speed tracks (see the Frequently asked questions for more details).
- Move XY and Move Z tools also work in Polygon mode.
- Delete command for objects.
- Duplicate command for objects.
- Creation of new objects (using the New/Duplicate command with no selected object).
- Texture browser and polygon texture selection.
- Help file (still incomplete).

Features still missing :
- Completed help file.
- Delete command for polygons.
- Duplicate command for polygons (affecting all resolutions).
- Split tool for breaking vertices common to several polygons (with automatic multi-resolution handling).
- Merge tool for re-uniting vertices.
- Merge tool for adjacent polygons.
- Rotating tool for object mode.
- Improved handling of objects when track blocks are moved.
- Erase-all functions : remove all turns, remove all objects, clear 3D structure.
- Adding/removing invisible walls.
- Multiple selection (in Point, Object and Polygon modes).
- Properties dialog boxes (all modes).



Downloading the latest version of T3ED

This is Preview Version 0.02 of T3ED, released on January 11, 1999.
T3ED is Copyright (c) Denis Auroux, 1998-99    (e-mail : auroux@clipper.ens.fr).

The latest version of T3ED is available from the official T3ED site at

http://www.eleves.ens.fr:8080/home/auroux/nfs/

New versions will also be announced and made available from NFSCheats (http://www.nfscheats.com/).



NFS3 Tracks Overview

Track structure
NFS3 tracks are subdivided into track blocks (ca. 200-300 of them), each of which consists of track 
vertices, polygons, objects and virtual road data. The corresponding data are mostly stored in a file with 
extension .FRD, and also in a companion file with .COL extension.

Vertices
These are the points which make up the track. They can belong either to the main track structure, or to an
"extra object" (see below).

Polygons
A track block consists of three series of polygons, corresponding to various resolutions (the low and 
medium resolutions are only used to save computing time when the car is still far away). To every polygon
corresponds a texture, and the high-resolution series of polygons is also associated with virtual road 
information.

Objects
There are two types of objects : the polygon objects (displayed in blue in T3ED) make use of the same list
of vertices as the main track structure, while the extra objects (displayed in green in T3ED) have separate
vertex information structures. The polygon objects are fixed and cannot be collided with, while the extra 
objects feature collision detection and can be animated as well.

Virtual Road
The virtual road is all the information used by NFS3 in order to compute the behavior of the various cars 
(player, police, opponents or traffic). This includes, in particular, a sequence of "virtual nodes" stored in 
the associated .COL file ; virtual forward and normal vectors associated to every high resolution track 
polygon ; and, optionally, virtual road lanes to guide the AI cars.

Textures
The track textures are stored in a companion file with .QFS extension. Four files are provided for each 
track : the files whose names end with a ‘0’ correspond to daytime racing, while those which contain a ‘1’
correspond to night racing. The files with a ‘_8’ suffix in their name correspond to 256-color textures, 
while the others correspond to 65536-color textures.



Frequently Asked Questions

When does the full version of T3ED come out ?
It all depends on how much time I can spare for working on T3ED. The full version ought to be available 
in February.

Does T3ED require any specific DLLs in order to work ?
Some Microsoft DLLs are required by T3ED : notably MFC42.DLL and MSVCRT.DLL. These files are very
widespread and it is extremely likely that they are already installed on your system. If not, they are quite 
easy to find as they are distributed with many recent programs, and they might even be available on 
Microsoft’s web site.

Where do I find the track files I’m supposed to edit in T3ED ?
The track files are located in the GAMEDATA\TRACKS\TRK00x subdirectories of your NFS3 installation 
directory. If there is no GAMEDATA\TRACKS subdirectory in your NFS3 directory, you must reinstall 
NFS3 in order to have the tracks loaded from the hard disk rather than from the CD-ROM.

Can I have both edited tracks and the original tracks at the same time in NFS3 ?
No. Unlike cars, tracks cannot be added to NFS3, so any edited track has to replace an original track.

How can I revert back to the original tracks ?
Simply copy the .FRD and .COL files from the GAMEDATA\TRACKS\TRK00x subdirectory of your NFS3 
CD-ROM back into the corresponding subdirectory of your hard disk NFS3 installation directory. In order 
to be able to modify again these files with T3ED, you will need to remove the Read-only attribute set by 
Windows when they’re copied from the CD-ROM.

How can I distribute a modified track ?
Just create a ZIP file containing both the .FRD and .COL files. People will be able to install the modified 
tracks simply by unzipping that file in the correct directory.

How can I make an oval (or a high-speed ring, or a straightened track) ?
First select Block mode in the Edit-Modes menu, and use the Smoothing properties dialog box (Alt-S) in 
order to activate the Extra-Smoothing option and to select a large value for the width of the smoothing 
zone (500 ought to be fine). Select the Move XY tool. By clicking on a track block and slightly dragging 
the mouse, you can remove all turns over a huge track section at once. Repeat this process two or three 
times on various track blocks in order to smoothen all the track. Next, select the Move Z tool, and repeat 
the process to remove the slopes.

Is it possible to modify textures or create new textures ?
T3ED is not a texture editor. You need to download a texture converter such as the QFS Editing Suite 
(available at http://www.eleves.ens.fr:8080/home/auroux/nfs/), which will let you convert QFS files into 
plain Windows bitmaps that you can edit using your favorite software.

Is it possible to add extra road sections ?
This is not possible with this version of T3ED. The final release will include functions for adding polygons 
to the track, but it will remain an advanced feature due to the complexity of the procedure.

I get an error message when attempting to save a modified track. What happens ?
T3ED is not able to create the modified track files. First of all, check that you are not trying to save your 
track on the CD-ROM drive. Also, both the .FRD and .COL files must have the Read-only flag cleared ; be
especially careful with this if you have copied the files back from their CD-ROM version. The Read-only 
status of a file can be modified in its properties box, obtained by right-clicking on the file.

The textures displayed in the texture browser look very bad. What can I do ?



Check that your Windows display is configured with a sufficient color depth. High-color or true-color 
modes (at least 16-bit depth, i.e. 65536 colors) are required in order for the texture browser to display 
textures correctly. In 256-color mode you will get garbled textures, even if you try working with the 8-bit 
textures.

I can’t view the textures because the QFS file has the wrong format. What happens ?
Some of the QFS texture files have an abnormal compression format, and cannot be decoded by T3ED. 
This is in particular the case with the 8-bit mode textures for the Summit track. When this happens, you 
should try loading a different texture file. In particular the 16-bit mode texture files take longer to load, but 
do not suffer from this problem.

Why can’t I use some of the tools ?
Since this is still a preliminary version of T3ED, some features are not yet implemented. Also, most 
commands are only available in specific editing modes (e.g. texture browsing is only possible in polygon 
mode).

When I race in NFS3, there are lots of display bugs. Why ?
First of all you should be aware that display bugs are partly unavoidable, because the track file formats 
are not yet fully understood and some of the necessary information is not known. However, the following 
general tips can be helpful :
- Never create sharp bends in the track which would cause some of the track polygons to overlap with 
each other. If you accidentally create such a sharp turn, you should use the Undo command to restore a 
correct track structure, and modify the Smoothing properties in order to increase the amount of 
smoothing.
- Use block mode whenever possible rather than the extended point mode. Block mode is the only mode 
in which all the relevant virtual road information gets updated when you move things around.
- Avoid creating slopes that are too steep, or things will tend to disappear in front of you when you race 
the modified track.

Is it possible to convert NFS2 tracks to NFS3 ?
This is an extremely complicated task which requires the development of specific tools. I will start working
on that project when T3ED is completed.

It doesn’t work, what can I do ?
You can send me a precise description of your problem by e-mail (auroux@clipper.ens.fr). Due to my 
limited available time, I will only help people who state clearly their problem and whose questions are not 
answered in this help file. If you get an error message, please state its exact contents. If you get 
suspicious behaviour, please indicate exactly what actions you performed and what happened.



File menu commands

The File menu offers the following commands:

Open Opens an existing track file.

Save Saves the opened track using the same file name.

Save As Saves the opened track to a specified file name.

Exit Exits T3ED.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Zoom In Zoom in.

Zoom Out Zoom out.

Translation mode Sets the translation mode : the scrollbars can be used to scroll the 
track view.

Rotation mode Sets the rotation mode : the scrollbars control the observer’s 
viewpoint.

Resolution Choose one of the three possible display resolutions.

Show Objects Shows or hides the track objects

Show Lanes Shows or hides the virtual road lanes

Re-center Center view on the current selection

Refresh Redraw screen

Edit-Modes menu commands

The Edit-Modes menu offers the following commands:

Block Selects block mode (the selection is a whole track block).

Point Selects point mode (the selection is a single point).

Xtended Point Selects extended point mode (the selection is a single point, with 
automatic smoothing).

Object Selects object mode (the selection is an object).

Polygon Selects polygon mode (the selection is a polygon).

Smoothing Modify the smoothing parameters for block mode or extended point 
mode.

Extra Smoothing Enable or disable extra smoothing for the move tools in block mode.

Edit-Tools menu commands

The Edit-Tools menu offers the following commands:



Undo Cancels the last modification of the track.

Move XY Selects the Move XY tool : drag the mouse in order to move the 
selection along horizontal directions.

Move Z Selects the Move Z tool : drag the mouse in order to move the 
selection along the vertical direction.

Delete Delete an object or a polygon (This command has only been 
implemented for objects in this release).

New/Duplicate Create or duplicate an object or a polygon (This command has only 
been implemented for objects in this release).

Merge/Split Selects the Merge/Split tool : control-left-click in order to merge 
vertices or adjacent polygons ; right-click in order to split 
vertices (This command is not yet implemented).

Texture View and modify the texture of a polygon.

Properties Display the properties of currently selected object (This command is 
not yet implemented).

Help menu commands

The Help menu offers the following commands: 

Help Topics Offers you an index to topics on which you can get help.

About Displays the version number of this application.



Open command (File menu)

Use this command to open an existing track file. A dialog box will appear to let you choose 
the file to open. 

IMPORTANT : Although you are prompted only for a .FRD track file, T3ED also 
simultaneously loads a companion file with .COL extension, which contains miscellaneous 
track data. If the .COL file is not available, T3ED will be unable to open the track file.

Shortcuts
Toolbar:

Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
*.FRD : NFS3 track files.

Drives
Select the drive in which T3ED stores the file that you want to open. 

Directories
Select the directory in which T3ED stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

IMPORTANT : Although you are prompted only for a .FRD track file, T3ED also 
simultaneously loads a companion file with .COL extension, which contains miscellaneous 
track data. If the .COL file is not available, T3ED will be unable to open the track file.



Save command (File menu)

Use this command to save the edited track to its current name and directory.    If you want to
change the name and directory of a track before you save it, choose the Save As command.

IMPORTANT : Besides the .FRD track file, T3ED also simultaneously saves a companion file 
with .COL extension, which contains miscellaneous track data. If you want to distribute the 
saved track, you must provide both the .FRD file and the .COL file. Also, both these files 
must be writeable in order for the save operation to be successful.

Shortcuts
Toolbar:

Keys: CTRL+S



Save As command (File menu)

Use this command to save and rename the edited track.    T3ED displays the Save As dialog 
box so you can name your track file.    

To save a track with its existing name and directory, use the Save command.

IMPORTANT : Besides the .FRD track file, T3ED also simultaneously saves a companion file 
with .COL extension, which contains miscellaneous track data. If you want to distribute the 
saved track, you must provide both the .FRD file and the .COL file. Also, both these files 
must be writeable in order for the save operation to be successful.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a track with a different name.    T3ED adds the extension 
you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

IMPORTANT : Besides the .FRD track file, T3ED also simultaneously saves a companion file 
with .COL extension, which contains miscellaneous track data. If you want to distribute the 
saved track, you must provide both the .FRD file and the .COL file. Also, both these files 
must be writeable in order for the save operation to be successful.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to exit T3ED.    T3ED prompts you to save the edited track if changes 
have been made since the last time it was saved.

Shortcuts
Mouse: Double-click the application's Control menu button.
Keys: ALT+F4



Undo command (Edit-Tools menu)

Use this command to reverse the last editing action, if possible. Up to 8 actions can be 
successively undone. Undoing is no longer possible once the changes have been saved to 
disk.

Shortcuts
Toolbar:

Keys: CTRL+Z or
ALT-BACKSPACE



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in T3ED.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to the most frequently used commands in T3ED.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To
Open an existing track.

Save the active track with its current name.

Zoom in.

Zoom out.

Select translation mode, where the scrollbars scroll the track view.

Select rotation mode, where the scrollbars control the observer’s view point.

Select block mode.

Select point mode.

Select extended point mode (single point with automatic smoothing).

Select object mode.

Select polygon mode.

Reverse the last editing action.

Select the move XY tool.

Select the move Z tool.

View and modify a polygon texture.

Delete an object or a polygon.

Create or duplicate an object or a polygon.



Select the merge/split tool for editing vertices or polygons (Not yet implemented).

Display the About dialog box.

Contextual help.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, as well as basic status 
information. A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the T3ED window.    To display or hide the status 
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar provide basic information about the current mode:

Indicator Description
Block nnn Indicates the track block to which the current selection belongs.
TRANSL/ROTATE Indicates whether the scrollbars are configured in Translation mode or 

in Rotation mode.



Zoom In command (View menu)

This command zooms in the document view by a factor of two. A total of 9 zoom levels are 
available.

Shortcuts
Toolbar:

Keys: ALT+PGDOWN



Zoom Out command (View menu)

This command zooms out the document view by a factor of two. A total of 9 zoom levels are 
available.

Shortcuts
Toolbar:

Keys: ALT+PGUP



Translation Mode command (View menu)

This command selects translation mode. In this mode, the scroll bars behave in their usual 
way (i.e. they scroll the track view).

Shortcuts
Toolbar:

Keys: F9



Rotation Mode command (View menu)

This command selects rotation mode. In this mode, the scroll bars control the observer’s 
view point rather than scrolling the view as usual. The horizontal scroll bar rotates the 
observer around the track along a horizontal circle, while the vertical scroll bar raises or 
lowers the viewpoint.

Tips

As T3ED is slightly slower in rotation mode than in translation mode, rotation mode should 
not remain selected as the default working mode when not necessary.

Raising the viewpoint to its top-most position can be very useful for optimal control of the 
Move XY tool. Conversely, lowering the viewpoint to the bottom-most position allows optimal
control of the Move Z tool, but since it tends to produce a display containing lots of 
overlapping polygons, it is sometimes best to work with a slightly raised viewpoint.

Shortcuts
Toolbar:

Keys: ALT+F9



Resolution submenu (View menu)

The Resolution submenu of the view menu can be used to select one of the three available 
resolutions for viewing the track polygons. The highest resolution is used in the game 
whenever the car becomes close enough, while the two other resolutions are used to save 
computing time when the car is still far away.

The lowest resolutions allow faster redrawing of the T3ED screen, but since some track 
vertices are not visible in these modes it is not recommended to work with them when 
moving track blocks (the highest resolution should always be used in order to ensure that 
the track structure is not messed up after a block is moved). Use of the low resolutions is 
also not recommended because it then becomes impossible to select a vertex which only 
belongs to a high-resolution polygon.

However, operations such as modifying polygon textures or deleting polygons must be 
performed in all three resolutions, and therefore require switching between the three 
available modes.

Full Selects full resolution.
Half Selects intermediate resolution.
Low Selects low resolution.

Full Resolution command (View menu)

This command selects the full resolution mode for viewing the track. Although this is the 
slowest mode, it is the only one in which all track vertices are displayed, and it is therefore 
strongly recommended to work in this mode when using the editing tools.

Operations such as modifying polygon textures or deleting polygons must be performed in 
all three available resolutions.

Shortcuts
Keys: ALT+1



Half Resolution command (View menu)

This command selects the half resolution mode for viewing the track. This mode is faster 
than the full resolution mode, but does not allow correct control of how the editing process 
affects the track structure. 

Operations such as modifying polygon textures or deleting polygons must be performed in 
all three available resolutions.

Shortcuts
Keys: ALT+2



Low Resolution command (View menu)

This command selects the low resolution mode for viewing the track. This mode is the 
fastest, but does not allow correct control of how the editing process affects the track 
structure. 

Operations such as modifying polygon textures or deleting polygons must be performed in 
all three available resolutions.

Shortcuts
Keys: ALT+3



Show Objects command (View menu)

This command enables or disables display of the track objects. The object editing commands
become unavailable when objects are not displayed.

NFS3 tracks contain two kinds of objects : the polygon objects, displayed in blue, are directly
incorporated into the main track structure and are immovable. The extra objects, displayed 
in green, are the only ones which allow the detection of a collision in the game, with the 
effect of either stopping the car (e.g. a tree) or moving the object (e.g. a road sign).



Show Lanes command (View menu)

This command enables or disables display of the virtual road lanes. The virtual road lanes 
are displayed in brown, and their purpose is related with the behavior of A.I. cars in the 
game. Unlike track polygons and objects, the virtual road lanes remain invisible in the game.



Re-center command (View menu)

This command recenters the view by placing the currently selected element in the middle of 
the T3ED window.

Shortcuts
Keys: HOME



Refresh command (View menu)

This command causes redrawing of the T3ED window, and should be used in the event of a 
display problem.



Block Mode command (Edit-Modes menu)

This help topic is not available in this release.



Point Mode command (Edit-Modes menu)

This help topic is not available in this release.



Xtended Point Mode command (Edit-Modes menu)

This help topic is not available in this release.



Object Mode command (Edit-Modes menu)

This help topic is not available in this release.



Polygon Mode command (Edit-Modes menu)

This help topic is not available in this release.



Smoothing Properties command (Edit-Modes menu)

This help topic is not available in this release.



Extra Smoothing command (Edit-Modes menu)

This help topic is not available in this release.



Move XY command (Edit-Tools menu)

This help topic is not available in this release.



Move Z command (Edit-Tools menu)

This help topic is not available in this release.



Texture command (Edit-Tools menu)

This help topic is not available in this release.



Merge/Split command (Edit-Tools menu)

This command has not yet been implemented.



Delete command (Edit-Tools menu)

This help topic is not available in this release.



New/Duplicate command (Edit-Tools menu)

This help topic is not available in this release.



Properties command (Edit-Tools menu)

This command has not yet been implemented.



Help Topics command (Help menu)

Use this command to display a list of available help topics.



About T3ED command (Help menu)

Use this command to display the copyright notice and version number of your copy of T3ED.



Context Help command 

Use the Context Help command to obtain help on some portion of T3ED.    When you choose 
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question 
mark.    Then click somewhere in the T3ED window, such as another Toolbar button.    The 
Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.    



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document. The arrow keys can also be used for the 
same purpose.

In translation mode, the scroll bars act in the usual way, by simply scrolling the track view. 

In rotation mode, the scroll bars are used to rotate the observer’s view point.



Close command (Control menus)

Use this command to close the active window or dialog box.

Shortcuts
Keys: ALT+F4 closes the T3ED window or a dialog box.



Modifying the Document

To edit a track, you need to use a combination of a selection mode and an editing tool. The 
available selection modes are listed in the Edit-Modes menu, and the available editing tools 
are listed in the Edit-Tools menu. In order to facilitate the editing process, the view 
parameters can be adjusted by using the commands in the View menu.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




